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NEXT MONTH+

June General Meeting:

John Mills (General Manager)
and Brian Sawkill (Senior
Technical Consultant) of
Staples will show us the new-
est toys presented at the com-
puter show in Las Vegas.

Nominations will be held for 15
minutes at the June meeting.
Please consider helping YOUR
club by sitting on the executive.
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Editor’s Korner
Send Letters to: editor@scug.ca

PRESIDENT’S
PERSPECTIVE

by Dorothy Alexander

Greg West - Editor

The month of May has traditionally been when
we open nominations for the SCUG executive
positions.  This year is no different.  So far we
have two positions that need to be filled.
Namely, Vice President and Public Relations.

Neither of these jobs requires a lot of your
time. Give it some thought; step forward and
volunteer for one of these positions   If you
know of someone, whom you feel could fill
these positions, please nominate them, or at
least prompt them to step forward. You can

contact either Dan Bilger or Bill Colotelo who are handling the nominations.   It is personally rewarding to be
part of the executive by helping make SCUG a better computer club.

Ladies, it is lonely being the only female on the executive so why not join me?

The current executive has worked hard to get interesting topics for the general meetings.  We intend to
continue in this direction in the coming year. Nominations remain open for the first fifteen minutes into  of the
June general meeting, then the election is held .

How many times have you installed a piece of software only to find that it was difficult to use?  I am sure that
all of us have been there and done that.  Frustration sets in and things really start to go wrong.  Many of you
have expressed that this has happened when using Microsoft WORD.  For instance the indents move on
you, when you do not want them to.  In fact sometimes it is as if it has a mind of it's own.  Well then, do not
miss our May General Meeting as we have Wendy Warner, Computer Department head of Northern Colle-
giate Institute & Vocational School, as our guest.  She will show us some of the tricks to use so this problem
hopefully will not occur.

Next month we will have John Mills (General Manager) and Brian Sawkill (Senior Technical Consultant) of
Staples to show us the newest toys presented at the computer show in Las Vegas.

GET INVOLVED

BE SURE TO COME NEXT MONTH AND VOTE - WE NEED YOU!

WE NEED YOU!
Last month we sent out a request for submissions by SCUG
members to send us some names of members of whom they
know are involved as volunteers within our community. We
must assume there is more than one volunteer within the SCUG

membership, and sadly, we only received one submission from a SCUG member
(see page 7).

SCUG has an election next month and we need you to help your club. Please
think to help your club by either volunteering for an executive position or simply
volunteering to help set-up a couple of meetings.

As well, SCUG is seeking articles for this newsletter. Nobody is sending in any
interesting finds on the Internet, nor are we receiving any TID BITS that we know
you have probably come across during your Internet travels. Do not keep these

gems to yourself. Share with your club members...please send in your interesting finds on the Internet...those
neat little programs that you just cannot do without...maybe the person sitting beside you can use that pro-
gram as well. Please participate in YOUR club. Send emails to: editor@scug.ca
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Your Secretary’s
Notes

by Tom Deeprose
secretary@scug.ca

Remember that it is volunteers who help make SCUG
the great club it is - SCUG needs your help with the
upcoming Executive Election. Please give some
thought to helping your club by volunteering to run
for a position. We need you to help ensure SCUG
continues for many years to come. Throw your hat
in the ring and have some fun.

SCUG Executive Meeting
May 1st, 2006 at St. James' Church
Ian and Jim sent their regrets.

1. Approval Of Previous Minutes: Accepted as writ-
ten

2. Membership Input:  In Jim's absence Ed reported
that, as of April end, membership stood at 136 (96
Members & 40 Associates) with five Members renew-
ing, plus nine current Guests. The meeting attendance
for the Carmen's presentation was 63 appreciative
Members and Guests. On the Newsletter, it was de-
cided that a 105 would be appropriate for the May GM.

3. Vice President's Input: No report

4. Secretary's Input: Nothing secretarial and accom-
modations are as published.

5.Treasurer's Input: Ed's current Financial Report for
April was approved with minimum comment.

6. Software Librarian's Input:  Pierre reported 44
disks given out at April GM plus$4 sales. DOM for this
month will be a program, Autostitch, enabling a pano-
ramic merging of landscape pictures

7. Newsletter Editor's Input: Greg is satisfied with
the current printing quality but is disappointed with a
lack of response to a request for feedback from the
membership

8. Program Coordinator's Input: Norm reports that
we have five reviews finished and nine outstanding at
various stages of completion.

9. Public Relations Input: Iain stated that the
Compuprize for May will be a
50/50 draw, and for June, a choice from a Wireless
Router, USP Unit and possibly a donation.

10. Webmaster's Input: Iain reported Website still
busy with international visits with the rate in March and
April at about 250/day. A couple of SIG leaders laptops
have been revised to accept wireless at St. James.

11. Meeting Program: Helge Buddenborg's presen-
tation on "Slides and Negatives to Computer Storage"

was enjoyed by all and gave a variety of options in deal-
ing with the transfer of all those old slides in the closet to
a handier medium.

   May: Wendy Warner, Head of Computers at North-
ern, major on WORD and minor on EXCEL

   June: Staples' John Mills and Brian Sawkill on new
technology from the Las Vegas Computer Show

     Ideas for the future: Computers in the medical field,
for instance, in Personal Insulin Control; using Quicken
etc.; the latest AskSam; MasterCard re. the computer
technology to be used for prepaid credit cards; how do
you prepare a DOM; making rubber stamps using the
computer; computer scrap booking. Some of these could
be combined as mini-presentations

12. Old Business - The revised Constitution. Tom will
announce to members at the May GM that the vote on
the revised constitution was originally set for May 31st.
However, due to a minimum of input we thought we
would remind everyone that we would accept comments
up to next Sunday, the 4th June for review at the Exect.
Meeting on the 5th. Any changes will be made and a
new copy sent to all members in preparation for a vote
at the June GM.

- The old projector- it was reiterated that it will remain
as backup and is also available to members on loan af-
ter brief instruction on its TLC. Disposal, when deemed
appropriate, will be by sealed bid or auction to mem-
bers only.

13. New Business The only positions open for the June
election are the VP and Public Relations. Ads for the
May meeting are too expensive to use
($80/day for the Observer) Pierre will look into cord-
less microphones for presenters since prices and vari-
ety have changed since we last evaluated them.

Next Executive meeting will be Monday, June 5th   2006
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Windows SIG

Computer SIG
&

Photography SIG
Pierre Houle

windows@scug.ca

SHAREWARE
SCUG Librarian

Pierre Houle
library@scug.ca

Free Program of the Month

SCUG ELECTION COMING SOON
Please give some thought to helping out your club by
volunteering for a position on the SCUG Executive.
Learn first-hand how the club works, join in on the
decision making, and bring your ideas to the table.
Oh yes and there is help...you will have lots of sup-
port in your new position. All you have to do is con-
tact an Executive member or Dan Bilger and Bill
Colotelo for info.

SKYPE - FREE PHONE CALLING
“Skype, eBay Inc.'s Internet telephone subsidi-
ary, has stopped charging users for dialing up
people on traditional landline and mobile phones
in the U.S. and Canada. "Millions of consum-
ers around the world are flocking to Skype
every month, and we believe free SkypeOut

calling will rapidly accelerate Skype adoption in the U.S.
and Canada," said Henry Gomez, general manager of
Skype North America” (Globe and Mail). Check out
free phone calling now at:
http://www.skype.com/

WINDOWS VISTA DELAY AGAIN
“An influential analyst firm is predicting that the
next version of Microsoft Corp.'s Windows op-
erating system will come out even later than
Microsoft has already forecast.  Researchers
at Gartner Inc. said in a report Tuesday that
they believe Windows Vista won't be broadly

available until sometime between March and June of
2 0 0 7 ” ( h t t p : / / b i z . y a h o o . c o m / a p /
060502microsoft_windows.html?.v=3).

MORE HIGHER-TECH SPAM
“Unless new weapons are designed to keep
junk mail at bay, spammers are about to get
the upper hand in the war in cyberspace. Ca-
nadian researchers have figured out a way to
create spam that could bypass the best filters

and trick even the most savvy computer users into opening
messages they would normally delete”
(www.courierpress.com)

DON’T PAY PER READ
How many times have you searched for some
news item, only to find that the site that hosts
the article wants you to set-up an account and
pay them money? Once is enough. The site
usually gives you a teaser paragraph to entice

you to pay. STOP right here. Next time, simply copy
the first sentence and paste it into the Google search
box. Make sure you put brackets around the text then
hit SEARCH. You will find many other sites that host
the very same article for FREE. Of course this does not
work all the time, but it is well worth the try (Editor
SCUG).

Due to vacations there will be no report this month. Look
for the reports next month.

Due to vacations there will be no report this month. Look
for the reports next month.

Some more TID BITS  from the editor@scug.ca

Remember:  Make sure to get your ticket when
you come to the SCUG General meetings so you
too can have a good chance at winning some of
the great prizes each and every month.
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Genealogy SIG

Val Conway
genealogy@scug.ca

SCUG
Compuprize Winners

Linux SIG

Rick Elnor
linux@scug.ca

Please get involoved with
your club and run for office.
Elections next month.

A dozen members were present for the April 25 Gene-
alogy SIG meeting at St. James.  The topic was "Gene-
alogy Software".  We discussed the need of using a pro-
gram and the availability of totally free and trial soft-
ware.

The three widely used programs available online are:
*Personal Ancestry file by the LDS which is free
(www.familysearch.org/eng/paf)
*Legacy will give you version 5 free
(www.legacyfamilytree.com)
*Family Tree Maker has a Starter Edition to use as a
trial (http://tinyurl.com/nnmu4).

Other programs can be found by going to
www.download.com and entering "Family Tree" in their
search.  A Review of the top ten genealogy programs
can be found at http://genealogy-software-
review.toptenreviews.com.

Kathy Witheridge demonstrated Legacy Version 5
showing many of it's finer points including how easy it is
to create a book.  Val Conway demonstrated Family
Tree Maker Version 11 showing the features she found
helpful.  Both Kathy and Val answered questions during
the demonstrations and discussed different techniques
of recording information.

This month's meeting was held on Tuesday May 30.
The topic was "Keeping your Data Credible"  (Entering
Evidence - Sources and Citations).  We learned the
definition of a source, why we need to record them how
to record them and where.

The  last Genealogy SIG meeting for the SCUG year
will be held on Tuesday, June 27 at St. James the Apos-
tle Church, 140 Lansdowne North, at Athlone from 7:00
p.m. to 9:00 p.m.  Once again this is the day before the
General Meeting.
Topic: City Directories, Newspapers, Inter Library
Loans, and other resources.  +

This past month at the Linux SIG meeting we took a
look at how to optimize Ubuntu Linux to use less sys-
tem resources and speed up overall system responsive-
ness. We also revisited the Crossover Office applica-
tion, which allows Windows programs to run within
Linux. There were only two members who attended
the meeting, however I am hoping to see a greater in-
terest in the future. I thank everyone whom has attended
our SIG meetings so far and am looking for any sug-
gestions on how to make the Linux SIG a greater
success.
_________________________________________

The whole gang of prize winners.

Many thanks to Helge Buddenborg, manager
of Carmen’s foto source for his kind offering of
prizes.

“A WIDELY backed effort is under way to create
a standard Linux desktop to help break
Microsoft's stranglehold. It is an effort to create a
single starting point for Linux distributions based
on standard elements.

As well as including the desktop and the ISO standard,
LSB 3.1 includes aligning LSB's roadmap with those
of major Linux versions, such as Asianux, Debian,
Novell and Red Hat. Linux has a foothold as an oper-
ating system for servers, but it has little of the desktop
market.”   (australianit.news.com)

Its desktop efforts have been blocked because Linux
supports two desktop systems, Gnome and KDE, mak-
ing it difficult for developers to create software that will
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SCUG is looking for members to review computer
books for O’Reilly Publishing. Anyone interested in
doing a book review, please contact:

Program Coordinator
Norm Lamoureux
coordinator@scug.ca

For a complete list of books at O'Reilly's go here:
http://www.oreilly.com/catalog/prdindex.html

SCUG Book Reviewers
Wanted

editor@scug.ca

GET INVOLVED WITH YOUR CLUB TODAY

Last month we put out a request for members to let us
know about SCUG members of whom they know are
volunteers in our local community. Sadly, only one mem-
ber sent in a submission. This club needs member par-
ticipation. Please start getting involved with your club
and help out.

SCUG member Pat Carter sent this letter to the Editor:

I would like to tell you about Norm Lamoureux.  He is
a wonderful dedicated volunteer in the Community. He
has been a member of SCUG since 1984.

In 1996 he started to Volunteer his time with Informa-
tion Sarnia Lambton www.informationsarnialambton.org
a database of community services in the City.  He is
currently the database Manager who updates the
Website.

He also helps a blind person with grocery shopping,
taking him to Doctor's appointments He helps VIP, a
local organization with volunteering, fixing computers,
and many other things they ask him to do,

He also Volunteers twice a week at the Local Food
Bank.

Myself a SCUG member he is always ready to help me
(a beginner in Computer) in many ways. I owe a lot of
my knowledge to him and his teaching and the fact he
always told me to try new things, without this urging I
would be less knowledgeable. (Pat Carter)

Please give this project another thought and send in
your submissions to the SCUG editor: editor@scug.ca

TID BITS

 Greg West
SCUG Editor

LOCAL POLICE REACH OUT - ONLINE

In today’s society we are seeing an overload of crime.
To help combat this the authorities utilize the Internet in
ways that in yesteryear was virutally unheard of, but now
is a reality.

The OPP have launched a new site wherein they actu-
ally show remains of crime victims in hopes that some-
one will recognize these people.  "The Ontario Provin-
cial Police and the provincial Office of the Chief Coro-
ner launched a Web site on Tuesday to help track down
missing persons and solve decades-old crimes.

The Web site, available through the OPP's main portal,
features pictures of missing persons and representations
of unidentified human remains. Distinguishing marks and
characteristics height, weight, piercings, tattoos, scars,
etc. are also provided to provide the maximum amount
of detail to visitors of the site."
www.opp.ca/Investigative/UnidentifiedRemains/
index.htm

Closer to home Lambton County now has crime media
releases online from the local OPP:
 www.crimealerts.net/lambton.htm

Windsor Police have their own online crime pages:
www.police.windsor.on.caMedia%20Releases%202006/
index.htm

London Police have a Wanted section online:
www.police.london.ca/WhatsNewhighriskwanted.htm

Back home again in Sarnia, we have our own boys in
blue reporting various local crimes:
www.police.sarnia.on.ca/
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Product Name: Microsoft Digital Image Suite 2006,
V11.0.422.0

What It Is: The suite is comprised of two elements - A
digital image Editor and a Library system for naming,
archiving and finding digital images.

Website: http://www.microsoft.com/products/imaging/
ProductDetails.aspx?pid=003 provides an overview and
a video tour of the product.

Tech Support: http://www.support.microsoft.com/ the
same for all Microsoft products.

User Manual: A 276 page manual in PDF format can
be downloaded for free from http://www.microsoft/
products/imaging/companionguides.aspx Chapters 12
through 15 are recommended reading for anyone inter-
ested in topics such as Taking Great Pictures, Success-
ful Scanning, Optimizing Your Monitor, and Digital Pho-
tography Tips & Tricks.

Price: Taxes not included - $99.95 US after $30 re-
bate as advertised at Microsoft product website. Pric-
ing applicable to SCUG members in Sarnia, Ontario,
Canada - Staples website price is $119.99 CAN after
a $40 rebate. For Digital Image 2006 Standard Edition
which is the editor only, price is $49.95 CAN after $20
CAN rebate. Future Shop website pricing is $69.99
CAN after $30 instant savings plus $40 mail-in rebate
for the Suite, and $19.99 CAN after $10 instant sav-
ings plus $20 mail-in rebate for the Standard Edition.
This price differential was double-checked at time of
writing. The winner is... http://www.futureshop.ca/search/
searchresult.asp?logon=&langid=EN&search=adv

Product Box Content: Two-disc wallet plus 276 page
hardcopy User Manual.

System Requirements: Win 98SE/Win ME/Win2000/
Win XP operating systems will support Microsoft Dig-
ital Image 2006 Suite. 256MB RAM minimum, 512MB
recommended. Minimum of 400MB hard-disc space.
If Windows Internet Explorer is not already installed,

A SCUG Review

Microsoft Digital Image
Suite 2006

by Rich Dolby
SCUG Member

then an additional 60MB HDD is required. This will not
replace your primary browser if other than Win IE al-
ready installed.

Installation:  The review was done using an AMD
1.15Ghz with 512MB RAM, operating with Win XP
Home edition Service Pack 2. An earlier version of
Microsoft "Picture It" or Digital Image" was detected
and remained operable after installing Microsoft Digital
Image 2006 Suite. A Typical Installation requires about
380MB, but I chose Full Installation forecast at 1300MB
which includes Clip Art, Templates and Sample Pictures.
There were no issues about installation to contend with,
just quick and easy.

What It Does: Microsoft Digital Image 2006 Editor
works on all digital images to enhance appearances,
soften or remove skin blemishes or wrinkles, do auto-
matic red-eye removal, straighten horizons or water lines,
remove unwanted artifacts or dust particles, extract
objects from images and create new images with multi-
ple layers in PNG format. There are Filters, Effects,
Brushes, Project templates for card-making, and Pano-
ramic Stitching together of multiple pictures. It is con-
sidered a very complete works, and a review such as
this has limited space to deliver an impression. If it is
photography you want this program for, then this is for
you, very affordable, an easy learning curve suited to all
family members. For the artists in the family, Editor takes
a picture and can create many special effects beyond
photography. It is highly recommended that time be
taken initially to view the video Tours, since it tickles the
imagination and generates confidence that you can do it
too. For comment about Microsoft Digital Image 2006
Library, please fast-forward to conclusions at review
end.

What it Does For Me:

1. Import digital camera uploads directly from Editor,
with opportunity to prefix filenames which are then suf-
fixed with an ascending three-digit serial number. For
example "20060430Canatara -001". The files are then
stored in a folder of choice. Can also import directly
from a scanner by the same method. Both my camera
and scanner were recognized by 2006 Editor. After files
have been captured, I can get to work on editing and
enhancement.

2. There are as many ways as there are people to use
2006 Editor. My way is to initialize as follows: Setup >
View > select Common Tasks, Stack, & Rulers. Then
go to Tools > Options > Units Of Measure, and change
Inches to Pixels. There are at least two target audiences
for this product - Photographers whose intent is print

Continued on page 8
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pictures at traditional standards of 4x6, 8x10 in inches
etc. Then there are people such as the reviewer who
rarely prints anything, preferring instead to view pictures
on a typical 4:3 ratio monitor. As such, pixel size and
ratio are catered to. For example, 2048x1536,
1600x1200, 1024x768, 640x480, and many sizes
inbetween those. When I crop or resize a picture it is
always with regard to maintaining ratio.

3. My main requirement is to edit and enhance digital
camera pictures. They can be edited one at a time or by
a Batch process that performs basic functions on many
pictures at a time. Picture file sizes, Batch size and avail-
able RAM are factors that will affect time for batch com-
pletion. If large multi-megabyte pictures, start with a small
batch size of say 5 pictures, then increase batch size if
time taken to execute the batch was acceptable. When
batch size is big relative to RAM, HDD space takes
over, and execution time takes much longer. Batch has
been found very useful for enhancing thousands of
scanned pictures of various colour quality and condi-
tion. I also have an old 0.8 Megapixel camera, and the
results are always improved by in turn correcting Level,
Contrast and Exposure. Colour correction by batch
correction can have varying results. Unless all colours
are faded the same in a batch, unwelcome results can
occur that can however be reversed by Edit > Undo.

4. You can make as few or as many corrections and
enhancements as you see fit, and have time for. For qual-
ity digital camera editing, I generally start by running a
batch of  about 20 pictures each 3 megapixel size, and
correcting Level, Contrast & Exposure. Any picture
requiring straightening is then done. Pictures are then
cropped individually to improve composition and to
lower the file size. The "Rule Of Thirds" gridlines box is
checked to assist cropping decisions. Colour correc-
tion is then done at this time, since working with JPEG's
is not lossless compression - each Save looses some-
thing. My preference for colour correction is to Edit
Curves which enables individual controls for Luminos-
ity, Red, Green, Blue, and Saturation. I adjust each in
the order given, and finish once again with Luminosity.
The objective is to enhance the picture to make it real
as was seen, with minimal adjustment of the "triangular
handles" at each end of the Curve. The Curve itself may
also be dragged by the mouse cursor, which can quickly
lead away from reality. You might concievably pull the
curves if a picture was wildly off base to begin with.
Luminosity is also applied sparingly so that shades of
white are discernable rather than being a white wash-
out.

5. If close-ups of people are being edited, then review
need for red-eye reduction and Smart Erasure of un-
wanted objects. Use Touchup > Other Photo Repair >

and select Remove Wrinkles, or Remove Scratches or
Dust, or Restore Old Photo. If close-up of a woman,
consider using Blur to soften skin texture, or use Sharpen
or Sharpen More if wanting to emphasize a non-person
image such as plumage or flowers. Blur or sharpening
should be the very last act done by editing and after final
re-sizing since extra pixels are added to create sharper
detail.

6. Some pictures can be made to be more dramatic by
using Effects > Filters > All Filters > select All, and tog-
gle down to Emboss Subtle, which defines object edges
in a chiselled way. The effect can be repeated several
times, and use Edit > Undo repeatedly to reset. It is
good advice to work on a copy of your "original" when
working in an artistic world where results are not pre-
dictable. Another interesting Filter is Glow: Edges, and
Change Advanced Options enables adjustment to those
parameters that create the effect, such as Transparency,
Edge Width, Edge Brightness, and Smoothness. If you
have time and inclination, there is much more to explore.
For example: Special Edges. Adjusting the width of Soft
Edges is a particulary nice effect for emphasizing the
picture focal point, great for multi-picture collages in
PNG format, which saves on ink too!

Conclusions:

1. After establishing that you are comfortable with the
new 2006 Suite, I recommend that any previous ver-
sion of Picture It or Digital Image Pro, be removed since
they are redundant and nearly 1GB of HDD space can
be reclaimed.

2. The Library management scheme is definitely not for
me, even if were free. I could not coax Library to sort
and show Thumbnails by filename, instead forced to view
either by Folder, Date, or Label. The latter is typically
Keyword, People, Places, Events, Flags, Ratings; and
more Label descriptors can be created to suit user
needs. In essence, the user must take time to build the
library using this Labeling system. Given the many thou-
sands of pictures already on my PC, I have no intention
of doing this. My "Labels" were built into the filename at
inception, and include such things as names of people,
date and place. Win XP Search feature is used to find
filename keywords, and copy results to a folder of
choice. If Library had the ability to view Thumbnails by
filename order, then I would keep the program, although
then more a repeat of what I already enjoy about
ACDSee and Irfanview, the latter being freeware.

3. The lifespan of 2006 Suite should be considered be-
fore choosing what to buy. Expect further refinements
to be made in future, sold as stand-alone software, not

Continued from page 7 - MS Digital Image

Continued on page 9
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as upgrades to existing software. What if the Label sys-
tem in Library was discontinued in future or your own
labeling scheme cannot be carried forward to a newer
edition? Your time investment could become obsolete.
Keeping it simple, I whole-heartedly recommend buy-
ing just Microsoft Digital Image 2006 Standard Edition,
it does exactly what is needed in support of Digital Im-
ages, and beyond. Instead of having several freeware
programs which if used consecutively might achieve simi-
lar results to 2006 Editor, go treat yourself to this all-
encompassing program.

4. A hardcopy User Manual is a rarity these days, but it
is clear that cost of production was lowered by having
only small black & white pictures which at times were
inadequate to show before-and-after comparisons. An
opportunity to address this problem was missed by not
having the website User Manual in colour with larger
pictures. The PDF document is about 5MB, easily in-
creased to achieve intended purpose.

5. If Microsoft Internet Explorer is not your primary
browser, it is said by product literature that it will not
become so, as a result of installing Digital Image 2006
Suite. One reason for this install is so those valued Flash
type SWF instructional videos can be viewed.
_________________________________________

One-click Access
to Frequently-Used Programs,

Files and Folders
by Glenn Richards

Member of the Lake-Sumter Computer Society
Leesburg, FL

grich32(at)yahoo.com www.lscs.us

There are certain files, folders, programs, and websites
I access frequently during the day.  To make this easy I
create shortcuts to them in my Quick Launch toolbar
that I keep normally hidden on the left side of my Desk-
top.  Moving the mouse cursor to the left side of the
screen unhides the toolbar, and a single left-click opens
the shortcut.

Every entry in the list at the left is a shortcut, so any can
be deleted without loss of the underlying program or
file.  However, Internet shortcuts like YQ will be de-
leted if the icon is deleted (but I keep a copy of it in my
Favorites folder).

The one thing that takes getting used to is that sweeping
the mouse cursor to the left edge of the screen may unhide
the toolbar, thereby obscuring icons on the Desktop or
menu choices on a window.  This is just a matter of not
letting the sharp point of the cursor get too close to the

edge of the Desktop window.

Since this toolbar auto-hides, it does not take up any
Desktop space.  When unhidden, by moving the mouse
cursor to its position, it moves out over icons at the left
edge of the screen, and does not force those icons to
shift over.

To start the QL Toolbar right-click an empty spot on
the Taskbar, Toolbars, Quick Launch.  Make sure the
Taskbar is not locked (right-click the Taskbar to see).
Move the mouse cursor to the "Handle" at the left end
of the QL toolbar to result in the double-pointed ar-
row), press and hold the left mouse button, drag to the
left edge of the screen, and release the mouse button.
Drag the edges of the resulting toolbar to the shape
shown.  Right-click an empty spot on the toolbar and
click "Always on top" and "Auto-Hide".  Other right-
clicks on this toolbar can lead to other options (I am
using large icons and no text).

I have created my own icons for many of the choices so
I can identify the functions from just the icon - but that is
another story.

To add a shortcut to this QL toolbar, right-click the
toolbar, uncheck Auto-Hide.  Then right-drag a pro-
gram, file, or other choice to the toolbar so a dark hori-
zontal bar appears, release the mouse button, click "Cre-
ate Shortcut Here."  The icon can be dragged up or
down the toolbar to whatever position you like.  Once
added, right-click the toolbar again and hide it.

There is no restriction against any non-profit group
using this article as long as it is kept in context with
proper credit given the author.  The Editorial Com-
mittee of the Association of Personal Computer User
Groups (APCUG), an international organization of
which this group is a member, brings this article to
you.
_________________________________________

“The Internet has grown in importance at
America’s work places to the point where
37% of fulltime workers, and 18% of part-
time workers, have Internet access at work.
Some 38 million fulltime workers in the na-
tion have Internet access at their jobs and two-
thirds of them (67%) go online at least once
per day.” PEW Research

Continued from page 8 - MS Digital Image
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Why Do You Get So Much Spam?
by Vinny La Bash

Member of the Sarasota Personal Computer Users
Group, Inc.

labash( at )spcug.org www.spcug.org

The earliest recorded instance of what may be described
as spam occurred on May 3, 1978.  A sales representa-
tive for Digital Equipment Corporation (DEC) named
Gary Thuerk sent a message to everyone on the Arpanet
data base (now known as the Internet) on the West coast
of the United States. Thurek wanted to notify the re-
cipients of an open house that his company was hosting
a demonstration of new models of the DEC-20 compu-
ter.

In 1978 the Arpanet had a certified "acceptable use
policy" which said it couldn't be used for anything ex-
cept research and education. Thuerk's action was a very
clear violation, and when DEC got a very strong re-
sponse from the Arpanet community objecting to the
misuse, the company promptly promised to stop.  Spam
would not appear again for many years.

Today, estimates of the amount of email that is defined
as spam range from 66% to 94%.  Whatever the actual
figure is, the good news, if you want to call it that, is that
spam appears to be leveling off.

Congress has passed anti-spam legislation.  Spam re-
ceivers are angry, Internet Service Providers try to filter
out spam messages, and spammers are loathed by the
general community of internet users.  Why do spammers
continue to operate in the face of all this general repug-
nance?

In an article for Wired Magazine, Brian McWilliams pro-
vides a very depressing answer.  McWilliams discov-
ered a security flaw on a website operated by a group
selling pills guaranteed to enlarge the male sexual organ.
The reporter found that over 6,000 orders for the product
had been placed in a time span of about a month.  Busi-
ness and medical professionals, athletes, and even
women bought the pills.  Many buyers made multiple
purchases at $50 per bottle, despite an obvious lack of
credit card security on the site.  The web site provided
no way to contact the company except by placing an
order.

Being a good reporter, McWilliams was not deterred
by the company's efforts to hide behind fake registra-
tion data, disconnected phone numbers, and phony email
addresses.  Eventually he revealed that the company
was owned by a 19 year old high school dropout, and a
neo-Nazi adherent.

The business appears to be highly profitable, net costs
being about $15 per bottle of pills, but according to the
FDA, there is no credible evidence that the product
works.

Now you know why you get so much spam.  It's be-
cause people who should know better respond to it and
buy products from these companies.

Selling products of dubious value is not the only kind of
spam on the net.  This week alone I have won three
European lotteries, and there are at least a dozen peo-
ple in Nigeria who each want to give me $12 million
dollars for helping them launder money.  Notification
came just yesterday that Bill Gates is going to give me
$500,000 because I forwarded a few emails for a good
cause.

Perhaps the best way to reduce the number of people
buying from spam is to educate people about the prob-
lem.  Unfortunately that takes time, but if we don't take
the time to tell people why they shouldn't buy from spam,
they will continue doing it.

If you are responding to spam, please stop.  Be part of
the solution, not part of the problem.

There is no restriction against any non-profit group
using this article as long as it is kept in context with
proper credit given the author.  The Editorial Com-
mittee of the Association of Personal Computer User
Groups (APCUG), an international organization of
which this group is a member, brings this article to
you.

_________________________________________
SPRING CLEANING

Gerry Says
By Gerry Gerstenberg

1st Vice President
Broward Personal Computer Association, Inc.Florida

www.bpca.org tutor101( at )earthlink.net

Here are some suggestions to get your computer back
up to speed.

Viruses Check your system for viruses and Trojans,
make sure that your antivirus definitions are up to date.
Viruses, worms, and Trojan Horses can all create seri-
ous system slowdowns.

If you're already running anti-virus software, make sure
the virus definitions are up-to-date. I use AVG from http:/

Continued on page 11
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/www.Grisoft.com. It is free as is Avast at http://
www.Avast.com. Only run one Virus Checker at a time.

Spyware/Malware Second, check your system for
spyware and malware. This can be done by using a
spyware detector like Ad-Aware found at http://
www.Lavasoft.com and/or Spybot Search and Destroy,
found at http://spybot.com/en/index.html. Keep them up
to date. I also use Microsoft Antispyware. It can be
downloaded from http://www.Microsoft.com.

Improve Online Security Install and configure a firewall.
Turn off unnecessary networking software. Download
and install Windows updates on a regular basis. Secure
your Web browser by using such options as setting its
"security zones."

Remove System Clutter Delete any unneeded icons from
the Windows desktop and Start menu tree. Each one
requires a little time to process when the system is boot-
ing up, and each one eats a little bit of system memory.
It seems like every bit of software you install these days
wants to claim its space on your desktop, whether you
need the program or not. Right click on Start then Prop-
erties then the Start Menu Tab.

Clean out fonts. Fonts are wonderful things. But unused
or useless fonts are a drag on system performance. Win-
dows loads all your fonts at bootup, just to keep them
handy in case an application needs them. But the more
fonts you have, the more resources Windows consumes
in keeping track of them. You probably have dozens of
fonts you won't ever need. Periodically go into Win-
dows Fonts folder - Start then run and type in
(C:\Windows\Fonts) and remove any unused Fonts.
Select each font (hold down SHIFT or CTRL while
clicking to select contiguous or noncontiguous groups,
respectively) and choose Delete from the File menu.
Double-click a font to view a sample.

Do a disk cleanup. This will remove some of the junk
that is cluttering up the temporary file folder. Click on
Start then All Programs then Accessories then System
tools and finally Disk Cleanup. Follow the instructions.
This process will take a few minutes.

Uninstall any software you will never use. Examples are
the AOL and other ISP installations preloaded at the
factory and any other preinstalled software. Access the
Control Panel, select Add/Remove Programs (Add/
Remove Programs in Win98 and WinMe), and system-
atically remove anything that isn't absolutely necessary.
You need to decide what is necessary to you. Reboot
after each uninstall for the best results.

Run MSCONFIG Go to Start then Run. Type in
msconfig and click on the startup tab. Then uncheck
any program you do not want to start when the compu-
ter starts. These programs take time to run when the
system starts up, and they take up precious system
memory. This will keep the icons from appearing in the
Windows Navigation Tray on the right side of the task
bar.

Defragment the hard drive. A full hard drive isn't your
only potential problem. Even with plenty of free space
on a drive, the file system can become so fragmented
that Windows can't efficiently access and store data.
The OS stores information on a hard drive in sectors.
When there aren't enough contiguous sectors available,
Windows stores parts of files in different places on the
disk and then keeps track of them all in a file allocation
table. Removing files and applications further scatters
sectors on the disk. Thus, over time, fragmentation oc-
curs as more and more files are split up and stored in
more and more places. And, because the system has to
search more places to find files and work harder to put
them together, fragmentation is a major drag on system
performance. Run Windows Disk Defragmenter tool to
rearrange files in the most optimal way. You may have
to reboot and defrag several times to get the hard drive
defragmented and the files compacted completely. From
the Start menu, open Programs, Accessories, and then
System Tools. Open the Disk Defragmenter utility. In
WinXP, let the utility analyze each drive to assess its
level of fragmentation and determine whether it's worth
defragging.

Do you have any running processes that don't need to
be running? Check this by doing Ctrl, Alt, Delete,
choose Process tab, make sure that everything that is
running is necessary. You can also try this to see what is
preloading: Start > Run, type in "msconfig" (without the
quotes) Click the Boot.ini tab and then select the /SOS
switch. Now instead of seeing that black and white
progress bar you will now see in real time what files are
being loaded. This can give you a clue where it is hang-
ing up.

Keep it simple. WinXP's default set of animations and
transitions is pleasing to the eye. But it doesn't do your
PC any favors, especially if your hardware is a couple
years old. All that sliding, fading, and shadowing takes a
toll on memory and processing power. But WinXP
animations aren't an all-or-nothing proposition. You can
customize which effects to use or let Windows handle
the decisions. Access your System Properties from the
Control Panel (or by right-clicking My Computer and
selecting Properties). Select Advanced then select Set-
tings under Performance. Select Adjust for best per-

Continued from page 10 - Spring Cleaning

Continued on page 12



12

SCUG Report:  Volume 23, Issue 7             April 2006

www.scug.ca

formance. All entries will be unchecked. You can then
selectively check any animations and transitions that you
would like to keep. Click apply and OK.

Windows' Disk Cleanup utility will help you free up hard
drive space, giving Windows and other applications
more room to work.

Navigate to the Advanced tab and select the Settings
button in the Performance category. Prioritize perform-
ance, appearance, or let Windows choose a middle
route. Alternately, choose the Custom option and en-
able or disable specific visual effects by checking or
unchecking their respective entries.

File System. Organize and maintain your files to keep
your PC running smoothly. Here are some tips for the
specific areas.

Make room. A full hard drive will bog down your sys-
tem on all fronts. For one, as the drive fills up, Windows
has to search more and more data to fulfill each request.
More importantly, though, a full disk hinders the OS'
ability to move files around temporarily and to manage
virtual memory. First, empty the Recycle bin. You can
easily lose hundreds of megabytes to files just sitting
around waiting to be fully deleted. Then, run Microsoft's
Disk Cleanup utility. From the Start menu, you will need
to go to Programs, Accessories, and System Tools.
Open Disk Cleanup, select the drive, and click OK.
The utility will analyze the system and offer suggestions.
Check each box and click OK. Next, uninstall unused
applications. From Windows' Control Panel, select Add/
Remove Programs. Remove any programs you don't
use, especially applications preinstalled by the manu-
facturer. Finally, archive infrequently used data to re-
movable storage.

Remove temporary files. Disk Cleanup doesn't get rid
of everything. Free up even more space by manually
searching for and deleting temporary files. Most appli-
cations use temporary files to store session-specific in-
formation, back up active files, and (in theory) delete
them when you close the pro-gram. But sometimes, for
a variety of reasons, temporary files aren't deleted. So
they sit, taking up valuable disk space, and not doing
anything remotely useful. Open Windows' Search tool
(called Find in Win98) from the Start menu. Find all files
beginning with a tilde (~) (search for "~*.*") and all files
with a .TMP file extension (search for "*.tmp"). Remove
any that aren't immediately associated with an open file
or application.

Perform regular maintenance. Don't make Disk Cleanup,
temporary file removal, Disk Defragmenter, and antivi-

rus scanning one-time activities. Without proper main-
tenance, system speed will continue to degrade need-
lessly. Schedule these activities using built-in tools (as
with most antivirus programs) or using Windows' Task
Scheduler. From the Start menu, navigate to Programs,
Accessories, and System Tools. Open Scheduled Tasks.
Double-click Add Scheduled Task to launch the Sched-
uled Task Wizard. Choose an application you want to
run (Disk Cleaner, for example), set the schedule, and
enter the login information of a user with permissions to
run the program.

A Little Goes A Long Way The secret to optimal PC
performance is recognizing that every little improvement
helps. By implementing a variety of techniques, includ-
ing those we just described, you'll slowly but surely see
system performance improve and maintain itself at a peak
level.

There is no restriction against any non-profit group
using this article as long as it is kept in context with
proper credit given the author.  The Editorial Com-
mittee of the Association of Personal Computer User
Groups (APCUG), an international organization of
which this group is a member, brings this article to
you.
_________________________________________

Web 2.0 and Portable Computing
By John Abbott

Member of the Bentsen Grove Resort Computer Club
Mission Texas J

ohn( at )bgrcc.com www.bgrcc.com

Portable Computing has always lagged behind the rest
of the computing market.  This is probably because there
are currently less mobile devices than computers.  But
that is about to change. According to Steve Rupel (leading
PR company on the planet) billions of mobile devices
will reach the market this year and by 2010 there will be
50 million of them sold quarterly.

Mobile device? You won't be calling them Pocket PC
or Cell Phone long; maybe PCC for Personal Commu-
nication Center. The merger of all forms of digital com-
munications is rapidly taking shape. Cell phones now
contain very limited access to the web, receive very lim-
ited email, and take limited resolution pictures - oh and
they work as phones too.  With smaller and more low
powered devices quickly coming on scene these limits
will expand exponentially.

My project over the past month has been the installation
of an Operating System on a USB Flash-memory De-
vice (UFD).  I started with a full blown Linux distribu-
tion on a USB 80 gigabyte micro hard drive. Well after

Continued from page 11 - Spring Cleaning
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some real torture and lots and lots of reading I managed
to get it operational. However, in editing the boot file I
managed to misspell something and now I've got to start
all over again.

But I did find a couple of small Linux distributions: Damn
Small Linux and Puppy Linux.  I downloaded the ISO
files for each and started working on a flash drive. To-
day I managed to get the thumb drive fully functional.
Along the way I've learned a lot about what I still need
to learn about executing from a CD or a UFD. But DSL
in a tube really works.

Why do this? Well because I know that Web 2.0 is
going to dominate the future of the web. With more and
more of the platform being located on the Internet, less
and less will be required on your local computer. The
computer will take on more and more of the role of thin
client (from a client/server relationship where all the ap-
plications are on the server). This in turn will have a
direct impact on the cost of computers which will no
longer have to come with expensive 3rd party software.
So I created a portable thin client.

Web 2.0 (platform on the web) will take away a great
deal of the chest thumping over O/S because the web
interacts with all operating systems. The feature rich web
already offers on-line mail processing that works per-
fectly with thin client or host computer. I am an advo-
cate of Google's Gmail. I can access it on the web where
it neatly threads my messages and stores up to 2.5
Gigabytes of mail in the in-basket or in the search able
archive.  From within that mail system I can also origi-
nate chats with my friends and maintain my calendar.  I
can make my calendar or part of it accessible to col-
leagues for event coordination.

I can use Zohowriter.com for my word processor. Zoho
is a full strength word processor with all the power you
find in Works, Word or Open Office (or any of the dozen
or so word processors available. I am able to store my
documents on-line, download them to my computer,
publish them on the site so they can be collaborated by
associates whom I have previously arranged access. I
can upload files from remote files (my computer or yours)
and modify and store or simply store them on-line. And
as an added feature I can use Zoho as a mail client;
sending, receiving and originating email. Zoho automati-
cally assigns you an email account when you register
(free).

There will be some who say: "well I can have several
programs open at once on my desktop."  And my re-
sponse would be, fine, I have multiple web pages open

on my computer as I use Zoho to write this. I have a
page set up with Wikipedia to check facts, the weather,
my Google mail, my personal mail web account, XM
radio playing great jazz.  And in a few moments I'll open
another and watch the news on TV - all from my thumb
drive.  I sure hope my Gizmo or Skype phones don't
ring during the news!

There is no restriction against any non-profit group us-
ing this article as long as it is kept in context with proper
credit given the author.  The Editorial Committee of the
Association of Personal Computer User Groups
(APCUG), an international organization of which this
group is a member, brings this article to you.

SCUG THANKS HELGE AGAIN

Once again, SCUG had the privilage of Helge
Buddenborg, manager of Carmen’s foto source giving
SCUG members an amazing talk on the future of
Photography...the Q&A session at the end is always a
great hit with members. This is where we learn from the
experts. Helge is a regular guest who has also spoken at
our Digital Special Interest Group meetings.

Continued from page 12 - Web 2.0
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SCUG Computer Disc Prices

CD Only Members Non-Members
Monthly Disk    Free      $2.00
Utilities  $1.00      $2.00
Additional Disks  $1.00      $2.00

NOTE:    Some of these programs are Shareware that come with a trial period, after which, they
                must be registered and paid for if you like them and decide to keep them on your machine.

SCUG Advertising Rates

Full Page 1x - $30.00 3x - $25.00 6x+ - $20.00
Half Page 1x - $20.00 3x - $15.00 6x+ - $10.00
Business card $10.00 per year

One year =  9 issues, September to June
Full and half page rates are per insertion

SCUG   MEMBERS   SAVE - UP TO $60 AT EBTECH

EBTECH offers up to $5/month discount to SCUG Members!

Contact Jim Lapointe (membership@scug.ca)
to be on the EBTECH Discount List.

For Members Only
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Slide and Film Scanning 35 mm
High Resolution

Call Pierre for a free quote

          Phone: 344-1379
          Email:  pahoule@sympatico.ca

GUESTS ARE WELCOME

Beginner
Average

Advanced
Computer Owners/Operators/Users

       COME OUT AND HAVE SOME FUN

ALL GUESTS WELCOMED
GENERAL MEETING

St. Bartholomew’s Church
718 Cathcart Blvd.

Sarnia, Ont.
--------------

Last Wednesday of the month
7:00 p.m. social time

  7:30 p.m. call to order

Meeting Schedule:
see the last page of this paper!

WANT TO SELL CAMERA EQUIPMENT?

Ask me about selling your
Cameras, Lenses, & Accessories

on Ebay.

Fred Abma
fab@xcelco.on.ca

SCUG members
can advertise
here for free.

Email your ad to:
editor@scug.ca

WANTED

Digital Projector for use with laptop.
For help at non-profit groups in Sarnia

Please Email:   editor@scug.ca

_________________________________________

FOR SALE

BLACK & DECKER SPACEMAKER 12
cup white coffee maker.
* Doing renovations and and cannot use.
* Nearly new.
* Mounts under your kitchen cabinet.
* Paid $89.99 + tax and will sell for half.
Phone: 542-4753.
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SCUG   MEETINGS  2006
Guests are Welcome to Visit

www.scug.ca

*THREE FREE MONTHS of MEETINGS for GUESTS*

Email us today:  president@scug.ca or check us out online:  www.scug.ca

Everyone is welcome to come to a meeting and receive a Guest Pass entitling you to sample
our various meetings over a 3 month period. An annual family membership in S.C.U.G. is $35.
This  allows you to attend all meetings, a free shareware program each month,  and a copy of our
monthly SCUG Report.

Come out and meet people like yourselves who want to learn about computers and digital pho-
tography. Go to our website for all details:  www.scug.ca

Many reasons for you to become a SCUG Member

*  Special Interest Groups *  Meeting Cancellation Notification
*  S.C.U.G. REPORT *  Local Discounts
*  Free Want Ads *  Earn 1 Month Free Membership
*  Paid Advertising *  Join in on Software Reviews
*  Disk of the Month *  Executive Postions
*  Utility Disks  (Set of 2 Disks) *  E-mail Reminders
*  Members Only Web Pages *  Special E-Mails

MEETING  LOCATIONS
*  Executive and Digital    - St James Church-140 Lansdowne North
*  Windows - PC                 - Grace United Church, 990 Cathcart
*  General Meeting            - St. Bartholomews Church, 718 Cathcart
*  Genealogy Meeting       - St James Church-140 Lansdowne North
*  Linux Group                    - St James Church-140 Lansdowne North

Jun   5                    Jun  7                         Jun 15                       Jun 28             Jun  27                Jun 13

SCUG ELECTIONS COMING SOON

SCUG   MEETING   SCHEDULE

Executive             Digital Photo             Windows-PC             General             Genealogy             Linux

www.apcug.org

If you want to help out on the SCUG Executive please contact anyone in the Executive. You can
also contact two past Executive members who have volunteered to assist in the Election process:

Dan Bilger: pinguyca@yahoo.ca
Bill Colotelo: bcolotelo@cogeco.ca

SCUG email address are found on page 1.


